
 

 

 

MCQ on Fundamental of computer 

१. MS word मा  टाइपमा र स्पेलिङमा हुने गल्ती परीक्षण गने सलुिधािाइ के भलनन्छ? 

a. Grammar checker 

b. Spell checker 

c. Word checker 

d. None of the these 

 २. सूचनाको सबैभन्दा सानो एकाइिाइ के भलनन्छ? 

a. A bit 

b. A byte 

c. A block 

d. A nibble 

३. कम्प्युटरका लिलभन्न भागको तथ्याङ्को प्रिाह र दरिाइ पररपुरण गनन अस्थाइ भन्डारण के्षत्र तोलककएको हुन्छ । त्यस भागिाइ के भलनन्छ ? 

a. Buffer 

b. Bus 

c. Channel 

d. Modem 

५. लडस्केट िा हाडन ड्राइममा कसरी डाटा भन्डारण गररन्छ? 

a. Ink 

b. Laser bubbles 

c. Magnetism 

d. Circuits 

६. लभलडयो मलनटरको सबैभन्दा सानो दृष्यात्मक भागिाइ पिक्सेल भलनन्छ ।  

७. कम्प्युटरको लचप के बाट बनेको हुन्छ? पसपलकन 

८. रो र कोिुमको रूपमा रहेको तथ्याङ्क गणना गने प्रोग्रामिाइ के भलनन्छ? स्प्रेडपसट 



 

 

९. लकिोडन, mouse, light pen र VDU मध्ये कुन आउटपुट लडभाइस हो ?  

10. Which is the input device? : Plotter, printer, VDU, and mouse. 

11. Notepad को extension के हो ? .txt, .xls, .ppt, .bmp' 

13. Which generation computer uses VLSI? 4th.  

13. BIOS के को िालग प्रयोग हुन्छ? (BIOS – Basic Input and Output System) 

a. By operating system 

b. By compiler 

c. By interpreter 

d. By application software 

1. Machine Language 
The machine language is sometimes referred to as machine code or object 

code which is set of binary digits 0 and 1. 

बुलटङ भन्नािे के बुलिन्छ? 

a. Restarting computer 

b. Install the program 

c. To scan 

d. To turn off 

A computer is accurate, but if the result of a computation is false, what is the main reason 

for it? 

a. Power failure 

b. The computer circuits 

c. Incorrect data entry 

d. Distraction 



 

 

GIGO: Garbage In Garbage Out. 

20) The central processing unit is located in the _____. 

a. Hard disk 

b. System unit 

c. Memory unit 

d. Monitor 

22) Which of the following is equal to a gigabyte? 

a. 1024 bytes 

b. 512 GB 

c. 1024 megabytes 

d. 1024 bits 

 

23) How many bytes does 4 kilobytes represent? 

a. 512 

b. 1024 

c. 4096 

d. 8192 

24) Which type of program acts as an intermediary between a user of a computer and the 

computer hardware? 

a. Operating system 

b. User thread 

c. Superuser thread 

d. Application program 

 

 



 

 

25) What kind of language can computer understand? 

a. Normal language 

b. Computer language 

c. Machine language 

d. High-level language 

28) What is the speed of computer measured in? 

a. Nanoseconds 

b. Kilo-seconds 

c. Gigahertz 

d. Megabytes 

29) What is the full form of RAM? 

a. Remote Access Memory 

b. Random Area Memory 

c. Remote Access Memory 

d. Random Access Memory 

30) What is the full form of DRAM? 

a. Dynamic Remote Access Memory 

b. Dynamic Random-Access Memory 

c. Dependent Remote Access Memory 

d. Dependent Random-Access Memory 

31) Which one of the following software applications would be the most appropriate for 

performing numerical and statistical calculations? 

a. Database 

b. Document processor 

c. Graphics package 

d. Spreadsheet 



 

 

32) Which of the following is not considered hardware? 

a. Operating system 

b. CPU 

c. Keyboard 

d. Hard disk 

33) Which of the following is exclusively a sequential access storage device? 

a. Hard disk 

b. Floppy disk 

c. Magnetic tape 

d. DVD 

34) Akshat has created a story of ten pages, but only wants to print the first two pages. 

Which printer command should he choose? 

a. Print all 

b. Print from 1 to 2 

c. Page setup 

d. Print Preview 

36) What is the full form of USB? 

a. Unshielded System Board 

b. Universal System Board 

c. Unidentified System Bus 

d. Universal Serial  Bus 

37) Which one of the following is not a form of data storage media? 

a. A database 

b. Magnetic tape 

c. Magnetic disc 

d. Optical disc 



 

 

38) What is five main components of a computer system? 

a. CPU, CD-ROM, Mouse, Keyboard, Sound card 

b. Memory, Video card, Monitor, Software, Hardware 

c. Modem, Keyboard, Word Processor, Printer, Screen 

d. CPU, Memory, System bus, Input, Output 

41) Select the correct statement from the following statements. 

a. MS-Excel creates workbooks, and each workbook may contain more work sheets. 

b. A worksheet in MS-Excel 2000 package has a maximum 0f 256 columns and 65536 

rows. 

c. Columns are identified by a number and rows are identified by a letter. 

d. Cells are identified by the column letter and the row number. 

i. a, b, c 

ii. b, c, d 

iii. c, d, a 

iv. a, b, d 

v. None of the these 

43) Which of the following would be the correct description for WORM virus? 

a. It infects the boot sector. 

b. It propagates through the internet and e-mail. 

c. It has no effect in increasing the internet traffic. 

d. It alters the folder structure. 

45) The use of the IC in a computer has ______. 

a. Increased the amount of heating 

b. Reduced the size and cost of computers 

c. Reduced the peripheral devices to be used 



 

 

d. Reduced the performance capacity of the computer 

46) Consider the following path C:\Device\Module\myFile. What is name of the file in this 

path? 

a. Device 

b. Module 

c. myFile 

d. C 

48) Which one of the following is not input device? 

a. Keyboard 

b. Mouse 

c. Speaker 

d. Scanner 

49) Which one of the following is an example of the browser software? 

a. Microsoft Word 

b. Notepad 

c. Internet navigator 

d. Internet explorer 

50) Which one of the following commands can be used to work on a file? 

a. Ctrl + XY 

b. Ctrl + 2 

c. Ctrl + C 

d. None of the these 

 

 

 



 

 

 

Operating System: 

CUI: Character User Interface जस्तैः DOS 

GUI: Graphical User Interface: Icon थिचेर कम्प्युटरसँग अन््रकृया गर्न सककरे् । जस्तैः विन्डोड १० 

Folder: Named Space to store files.  

File: Documents, tables, graphs prepared by the user. Files have extension. 

Icon: small pictures available on Operating system/ computer screen by clicking them user can 

give command to the computer. Icons are available in GUI 

 

Microsoft Office Package (MS Office Package) 

1. MS Word. 

1. File extension .doc  or .docx 

2. MS Excel 

1. File extension .xls  or .xlsx 

3. MS Power point 

1. File extension .ppt  or .pptx 

4. MS Word कसरी खोलरे्ैः Start icon मा क्लिक गरे्, MS word टाइप गरे् र enter थिच्रे् िा MS 

word को आइकर्मा क्लिक गरे् ।  

 

  



 

 

Microsoft Word 

 

 

 

 

Microsoft Word: Word Processing Package/software 

Function: लचठी पत्र, Desktop publishing लकतािहरू तयार गने, ब्रोसरहरू बनाउने 

Mail merge: धेरै जनाको एडे्रस र एउटा लचठीको फमेट बनाएर सबैको ठेगाना सलहतको लचठी बनाउने सुलिधा । 

Researcher को िालग Reference सुलिधा छ ।  

Comment, Edit, spellchecker, Paragraph लमिाउने (Paragraph formatting), indenting, Document िाइ 

Format लमिाउने सुलिधाहरू यसमा छ ।  

टेििहरू बनाउने सुलिधा छ ।  

Microsoft office िाइ 4th Generation language of computer पलन भलनन्छ लकनभने यसमा high level language प्रयोग 

गरेर program codes िेख्ने सुलिधा पलन छ ।  

Programming language: 3 Types 

• Machine language: 0 and 1 प्रयोग गरी कम्पपुटरिे लसधै बुझ्ने भाषामा Programming गने ।  

• Low level language: Mnemonic Codes प्रयोग हुने Language 

• High level language: Human language प्रयोग गरेर program िखे्न सलकने ।  

Redo 
Ctrl+Y 

Undo 
Ctrl+Z 

App 
icon 

Save Command 
menu 

Ribbon for 
direct click 

Working Space / 
White space 



 

 

Menu 

File:  

 

New: नयााँ फाइि बनाउने (CTRL+N) 

Open: पुरानो फाइि खोल्ने  Alt+Ctrl+F2 

Save: नयााँ फाइल सेभ गने वा िुरानो फाइल edit गरेिपि सेभ वा सुरक्षीत गने . CTRL+S 

Save as: सेभ भै सकेको फाइललाइ नयााँ नाममा सेभ गने काम हो । वा नयााँ स्प्थान वा फोल्डरमा सेभ गनन ।  

Print: CTRL + P Current Page खोिीरहेको पेज िा जुन पेजमा तपाइ हुनुहुन्छ सो पेज, सबै पेज िा Selection गरेको 

text छा्ने काम ।  

Output: 2 Types: छापीएको िाइ Hard copy output 

Computer मा मात्र देलखने िाइ Soft copy output/electronic copy or eCopy. 

Share: email, viber, messenger मा लसधै पठाउने कामको िालग 

Export: अन्य फमेटमा ढािेर सेभ गने 

Close: तपाइको खुिेको फाइि बन्द गने तर Word software चाही चिी राख्ने ।  CTRL+W 

 Option: Grammar, Language, Auto correct option  

Ribbon: The space for buttons to click for any function below menu and above the ruler.  

Date: 2078/9/28 

 

1. जुन text िाइ लमिाउने हो त्यसिाइ select गने: CTRL+A (Select All), Word मा double click, triple click? 

2. दायााँ लतर राख्नः CTRL + R 

3. बााँया लतर िानः CTRL + L 

4. Centre िा बीचमा राख्न CTRL + E 

5. Justify गननः CTRL + J 

6. अक्षर ठूिो पाननः CTRL + ] िा CTRL + Shift + > 

7. अक्षर सानो पाननः CTRL + [ िा CTRL + Shift + < 

8. पुरै text select गननः CTRL+A 

9. एउटा िाइन select गननः माउसिाइ िाइनको देब्रे लतर िाने र माउस देलखए पलछ एक पटक त्यही ललिक गन े

10. एउटा मात्र शब्द Select गननः double click on the word 

11. Select the paragraph: triple click on the paragraph  



 

 

12. Save the document: CTRL + S 

13. Close the file but don't exit from Word: CTRL+W 

14. Copy the text: Select the text then press CTRL + C 

a. Cut the text: Select the text then press CTRL+X 

b. Paste The text: CTRL + V 

c. Paste format: CTRL+Shift+C गरी CTRL+Shift+V गने 

15. What is difference between copy and cut command?  

a. Copy गदान छनोट गररएको text पुरानो ठाउाँमा पलन रहन्छ तर cut गदान पुरानो ठाउाँमा रहाँदैन तर Paste गरेपलछ दुबै तररकािे नयााँ ठाउाँमा िान सलकन्छ ।  

16. Formating the text: 

a. Undo: CTRL + Z and RE-DO: CTRL+ Y   

i. तत्काि गरेको काम रद्ध गनन UNDO र तत्काि गरेको काम पुन दोहोयानउन RE-DO गनुन पदनछ । 

b. Bold the text: CTRL+B 

c. Italic face of text: CTRL + I 

d. Underline the text: CTRL + U 

e. Double underline: CTRL+Shift+D 

f. Super-script and Sub-script: 

i. Superscript भनेको अक्षरिाइ मालथ िेख्ने जस्तै a2 . यहा 2 िाइ superscript मा िेलखएको छ । subscript भनेको ति िुन्डाइएको अक्षर हो । 

जस्तै H2 । यहााँ 2 sub-script मा छ ।  

Superscript: CTRL + Shift + (plus sign) 

Sub-script: CTRL + (Plus sign) 

Or, just click on X2 or X2  in the home menu ribbon icon.  

 

  



 

 

Home menu:  

• Undu (Cancel last actions) and Redu (Repeat last actions) 

• Paste: कपि गरेको टेक्स्प्टलाइ नयााँ ठाउाँमा राख्ने काम । Paste गननका लापग copy गररसकेको हुनु ििन । 

o कपि गने (Select the text and press CTRL+C and paste in a file location by CTRL+V) 

• CUT and Copy: Cut िे select गररएको text िाइ कलप गछन तर पलहिेको ठाउाँबाट हटाउाँछ तर Copy िे पुरानो ठाउाँमा पलन हुन्छ र कलप पलन गछन ।  

•  

 

 

B= Bold the text CTRL + B 

I = Italics the text CTRL+I 

U : Underline the text CTRL+U 

 

 

Sentence case: First letter capital until full stop.  

Lower Case: all small letter 

UPPER CASE: ALL CAPITAL LETTER 

Capital Each Word: 

tOGGLE cASE: Capital िाइ small र small िाइ capital letter बर्ाउरे् । 
Hari   ACHARYA  
 

CTRL+A = Select all 

CTRL+B = make text Bold 

CTRL+C = Copy 

CTRL+D = Font dialogue box 

Cut 

Copy 

Format Copy 

Paste 

Font 

Change 

Font Size 

Increase 

the font 

Size 

CTRL+ > 

or 

CTRL+ } 

Decrease 

the font 

Size 

CTRL+ < or 

CTRL+ { 

Highlight 

the text 



 

 

CTRL+E = Centre aline the text 

CTRL+F = Find 

CTRL+H = Replace, CTRL+I = Italics. CRTL+J = Justify 

CTRL+K = Insert Hyperlink 

CTRL+L = Left align 

CTRL+M = Paragraph indenting  

CTRL+N = make new file 

CTRL+O = Open file 

CTRL+P = Print 

CTRL+Q = Left align the paragraph 

CTRL+R = Right align the text.  

CTRL+S = Save the file 

CTRL+U = Underline 

CTRL+V = Paste 

CTRL+W = Close the file ्र बाहिर र्जारे् 

CTRL+X = Cut 

CTRL+Y = Redo 

CTRL+Z = Undo 

NEPALI UNICODE: ALT+SHIFT  

EXIT FROM UNICODE: ALT + SHIFT 

ALT + TAB: Show all open windows (applications) 

Formatting the Word Document: Word Document िाइ Bold, Italics, Underline, Center, Right and Left 

align गरे्, Paragraph ममिाउरे्, Tab हिरे्, Left and Right margine हिरे्, Gutter Space हिरे्, Color change गरे्, 

Line space ममिाउरे्, Heading level िरू ममिाउरे् आहि कामिाइ Formating भनर्न्छ । VVIMP 

1. Bullet and Numbering: 

a. List: Order र्िुरे्िाइ, First, second, third … यस्ो क्रम र्िुरे्िाइ बुिेट हिइन्छ । 



 

 

 

b. Numbering: Order िुरे् िाइ numbering गररन्छ ।  

 

Heading and Title 

Title of the book 
First Heading or Heading 1. (Biggest number) 

Second Heading or Heading 2.  

Heading 3 

Heading 4 

 

Editing menu: Find (CTRL + F), Replace (CTRL+H), Select text or object (Figure) 



 

 

 

 

Insert Menu 
To insert Table, pages, Picture, Auto shapes, Chart, Comment, Header, Footer, Page 

number, Text box, Equation (ALT with + ) , Symbol © 

 

मसधत ममर्ुमा जार् ALT थिच्र् े। अनर् ममर्ुमा underline भएको अक्षर थिच्र्े ।  

Draw Menu 

यो अफिस प्याकेजमा नयााँ ममनु हो । यसको प्रयोग गरेर मसधै कम्पप्युटरमा चित्र 

कोनन सफकन्छ ।  
 

 

For short cut: Press ALT+ J I  



 

 

Design Menu: File को फमेट डडजाइर् गरे् जस्त िेमसस, व्रोसर आहििाइ अटोमेहटक डडजाइर्मा राख्नको िाथग । 
किरऽ फन्ट, Watermark, Page boarder, Page color राख्न ।  

What is water mark: This is a background text that can be displayed in a document. 

 

Layout Menu: Margin, Orientation (Protrait (Vertical), Landscape (horizontal), File size (A4, A3, …) 

Paper size: 



 

 

  

Break: Page break (CTRL+Enter) अको पेजबाट सुरू गने कामको लाचग,   अन्य ब्रेकहरू Section break, Line 

number आपि हनु् । 

Indenting: Word मा िाइललाइ दायााँ वायााँ तल र माथी कतत स्पेस छोड्ने, लाइन स्पेस before and after कतत 
ददने भन्ने कामलाइ indenting भतनन्छ । यसको लाचग Layout menu बाट वा Ruler बाट पतन गनन सफकन्छ ।  

indent or indentation is the increase or decrease of space between the left 

and right margin of a paragraph. To indent text, move the cursor to the front 

of the line and press the Tab on the keyboard. Example of indented text. 



 

 

 

 

रुलरबाट मसधै Indent गननका लाचग 

 

 

 

 

Indenting: Word मा िाइललाइ दायााँ वायााँ तल र माथी कतत स्पेस छोड्ने, लाइन स्पेस before and 

after कतत ददने भन्ने कामलाइ indenting भतनन्छ । यसको लाचग Layout menu बाट वा Ruler बाट पतन गनन 
सफकन्छ । VVIMP 

 

 

 

 

 

 

 

 

 

 

 

 

  

First line indent 

Left indent or Hanging indent Right indent 

Left Indent (CTRL+L) 

देव्रेततर मसधा राख्न े

Word मा िाइललाइ दायााँ वायााँ तल र माथी 
कतत स्पेस छोड्ने, लाइन स्पेस before and 

after कतत ददन ेभन्ने कामलाइ indenting 

भतनन्छ । यसको लाचग Layout menu बाट 
वा Ruler बाट पतन गनन सफकन्छ ।  

 

Centre Indent (CTRL+E) or Centralize 

वविमा राख्न े

Word मा िाइललाइ दायााँ वायााँ तल र 
माथी कतत स्पेस छोड्न,े लाइन स्पेस 
beforeand after कतत ददने भन्ने 

कामलाइ indenting भतनन्छ । यसको 
लाचग Layout menu बाट वा Ruler बाट 

पतन गनन सफकन्छ । 

 

िल्स राइट or Right indent (CTRL+R) 

दादहने ततर मसधा राख्न े

Word मा िाइललाइ दायााँ वायााँ तल र माथी कतत 
स्पेस छोड्ने, लाइन स्पेस before and after कतत 
ददने भन्ने कामलाइ indenting भतनन्छ । यसको 

लाचग Layout menu बाट वा Ruler बाट पतन गनन 
सफकन्छ । 

 

Justify (CTRL + J) दुब ै ततर लाइन मसधा भएर 
ममल्ने 

Word मा िाइललाइ दायााँ वायााँ तल र माथी कतत 
स्पेस छोड्ने, लाइन स्पेस before eand after 

कतत ददने भन्ने कामलाइ indenting भतनन्छ । 
यसको लाचग Layout menu बाट वा Ruler बाट 
पतन गनन सफकन्छ । 

 



 

 

View Menu: 

 

Read mode मा लकताि जस्तो गरी पुरै स्कृनमा पढ्न सलकन्छ, Print मा कस्ो 
िेखखन्छ त्यस्ो िेर्न Print layout, website जस्ो गरी िेर्न Web 

Layout, Text मात्र िेर्न outline, Text मात्र Format नदेलखने गरी हेनन Draft मा 

लथच्नु पछन । 

Focus: यो पलन अक्षरमात्र हेने र अरूलतर ध्यान नजाओस भनेर प्रयोग गररन्छ ।  

Zoom: ठूिो बनाइ हेनन िा सानो बनाइ हेनन प्रयोग हुन्छ । यसिे पुरै फाइि हेननको िालग मात्र ठूिो िा सानो बनाउाँछ तर font 

size बास्तलिकमा पररितनन भएको हुाँदैन । तपाइिे Zoom लथच्नु भयो भने तिको dialogue box देलखन्छड्ड 

 

200% ठूिो बनाइ हनेन  200% मा लथच्ने । 75% मा घटाएर हनेन 75% मा लथच्न,े एकै पटक धेरै पेजहरू हेनन 

many pages मा लथच्ने । प्रलतशत घटाउन बढाउन Percent मा ति िा माथी लथच्ने । यो काम स्कृनको 

दालहने पुछारको कुनामा भएको slider िाइ दायााँ िगे ठूिो हुन्छ (zoom in) र िााँयााँ ल्याए सानो (Zoom 

out) हुन्छ ।  

 



 

 

  



 

 

Sub-script and Super Script (VVIMP) 

H2O, (a+b)2 

H2 – Here 2 is in subscript. It is a downed/hanging text. (CTRL+ +) or Click on X2 in 

the ribbon of home menu. 

(a+b)3 – Here 3 is at superscript (CTRL+Shift+ +). You can click on X2. 

 

Help menu 

कुनै कुरा नजानेमा खोजी गरी हेनन help menu लथच्नु पदनछ । यसको short cut key F1 key हो ।  

Function keys in MS word 

There are 12 function keys. The work of function keys are given below: 

F1: Get help 

Shift+F1: Open Word’s “Reveal Formatting” pane, where you can see the 

character and paragraph formatting of whatever text you have selected. 

Alt+F1: Jump to the next field if you’ve got fields in your document. 

Alt+Shift+F1: Jumps to the previous field in your document. 

 

F2: Move text or objects. Select the text or object you want to move and then hit 

F2. Place your insertion point where you’d like to move the item and then hit 

Enter. 

Shift+F2: Copy selected text. It’s just like hitting Ctrl+C. 

Ctrl+F2: Open the Print window, where you can preview and print your 

document. 

Alt+Shift+F2: Save your document. If you haven’t saved your document 

previously, it opens the Save As window. 

Alt+Ctrl+F2: Pop up the Open window so you can open a document. 

F3 



 

 

F3: Expand an AutoText entry. Type at least the first four letters in the name of 

your AutoText entry and then press F3 to expand it to the full text. 

Alt+F3: Create an AutoText entry from selected text. 

Shift+F3: Change the case of selected text. Pressing this combo repeatedly cycles 

through the following case styles: Initial Letter Case, ALL CAPS CASE, and lower 

case. 

Ctrl+F3: Cut selected text to the Spike. You can cut as much text as you want this 

way and it all accumulates on the Spike. 

Ctrl+Shift+F3: Insert the contents of the Spike. Performing this action also clears 

any text in the Spike. 

F4 

F4: Repeat your last action.  

Shift+F4: Repeat the last “Find” action. This one’s handy because you can use it 

to browse search results without having the Find and Replace window or 

Navigation pane open. 

Ctrl+F4: Close the current document. You’ll be asked to save the document if 

you’ve made any changes. 

Alt+F4: Quit Microsoft Word. This closes all open documents (giving you the 

chance to save changes first) and exits Word. 

F5 

F5: Open “Go To” tab on the Find and Replace window. You can use this to 

quickly jump to a page, section, bookmark, and so on. 

Shift+F5: Jump the previous edit you made in your document. Press it again go 

one more edit back. Word remembers your last two edits. This works even after 

saving and closing a document, letting you return to where you left off when you 

open the document again. 

Ctrl+Shift+F5: Open the Bookmark window so you can edit bookmarks. If your 

insertion point is in an existing bookmark, pressing this combo opens the 

Bookmark window and selects that bookmark. 



 

 

F6 

F6: Go to the next pane or frame in your Word window. You can use this to 

navigate the window without using your mouse. 

Shift+F6: Go to the previous pane or frame. 

Ctrl+F6: Go to the next open document window. 

Ctrl+Shift+F6: Go to the previous open document window. 

F7 

F7: Open the Editor pane and start a spelling and grammar check. (Imp) 

Shift+F7: Open the thesaurus. If you have a word selected when you press this 

combo, Word opens the thesaurus and looks up the selected word. 

Alt+F7: Find the next spelling or grammar error in your document. 

Alt+Shift+F7: Open the Translation pane. 

F8 

F8: Enter Word’s selection mode and expand a selection. While in this mode, you 

can use the arrow keys to extend your selection. You can also press F8 up to five 

times to extend the selection outward. The first press enters selection mode, the 

second press selects the word next to the insertion point, the third selects the 

whole sentence, the fourth all the characters in the paragraph, and the fifth the 

whole document. 

Shift+F8: Reduce a selection. This works the same way as expanding a selection, 

but backward. 

Ctrl+Shift+F8: Selects a column. Once the column is selected, you can use the left 

and right arrow keys to extend the selection to other columns. 

F9 

F9: Update a field. This is the same as right-clicking a field and choosing the 

“Update Field” command.  

Shift+F9: Reveal a field’s code. 



 

 

Ctrl+F9: Insert new Empty Field {} braces. 

Ctrl+Shift+F9: Unlink a field. 

Alt+F9: Toggle the display of a field’s code. 

F10 

F10: Show key tips. Pressing this combo reveals single letter shortcuts you can 

use to access Word’s menu commands. 

Shift+F10: Display a context menu. This works just like right-clicking. 

Ctrl+F10: Maximize document window. 

Alt+Shift+F10: Display a menu or window for an available selection. 

F11 

F11: Jump to the next field in your document. 

Shift+F11: Jump to the previous field in your document. 

Ctrl+F11: Lock a field so it cannot be edited. 

Ctrl+Shift+F11: Unlock a field. 

Alt+Shift+F11: Start the Microsoft Script Editor. 

F12 

F12: Open the Save As window. 

Shift+F12: Save your document. 

Ctrl+F12: Open the Open dialogue box. 

Ctrl+Shift+F12: Open the Print dialogue box. 

 

  



 

 

Status bar of MS word 

िडनमा स्टाटस बार भन्नािे स्कृनको पुछारमा हुने bar िाइ जनाउाँछ । लचत्र हेनुनहोस ्

 

Status bar िे तपाइको कसनर कुन पेजमा छ र कलत पेजको डकुमेन्ट छ भन्ने देखाउाँछ । साथै कुन भाषामा language को 

grammar चेक गने हो सो देखाउाँछ । साथै read mode, focus mode जस्ता कुराहरू के प्रयोग भएको छ पलन बताउाँछ ।  

A feature of MS Office that saves the document automatically after certain interval is 

called ____? 

 

A. Save 

B. Save As 

C. Auto save 

D. None of the above 

What was the HTML editor that was part of Microsoft Office until 2003? 

 

A. Web page 

B. Front page 

C. Explorer 

D. None of the above 

Submitted by: Naveed Tahir 

Which feature is used to make selected sentence to All Captital Letters or All Small 

Letters ? 

0  

A. Change case 

B. Change letter 

C. Change sentence 

D. Change word 

Submitted by: Naveed Tahir 

In Ms word, a master document contains _______ of subdocument ? 

0  

A. Placeholder 

B. Files 

C. Links 

D. Same data as 
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Submitted by: Farhan Rana 

Read More Details about this Mcq 

In Microsoft Word, ____________ can be used to decide on the spacing between lines of a 

paragraph. 

0  

A. Alignment 

B. Effects 

C. Indentation 

D. Line spacing 

Submitted by: Zohaib Hassan 

In MS World 2007, ______ is used to move directly to specific location in a document. 

0  

A. Sub documents 

B. Bookmarks 

C. Cross-references 

D. Outlines 

Submitted by: Dilawar Hussain 

Which option use to open recent file? 

0  

A. Ctrl+R 

B. Ctrl+F 

C. Ctrl+O 

D. Ctrl+N 

Submitted by: Moazam Ali 

All caps to selected text in MS Word is applied with? 

0  

A. Alt+shift+A 

B. shift+A 

C. Ctrl+shift+A 

D. None of these 

Submitted by: Anwar 

Which feature starts a new line whenever a word or sentence reached a border 
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0  

A. Text Line 

B. New Line 

C. Text Wrapping 

D. Text Align 

Submitted by: Anwar 

Text-styling feature of MS word is? 

0  

A. Word Color 

B. Word Font 

C. Word Art 

D. Word Fill 
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Microsoft Excel 

Microsoft Excel पलन अफीस ्याकेजको एउटा सफ्टिेयर हो जसिाई spreadsheet  पलन भलनन्छ । IMP 

MS Excel is a commonly used Microsoft Office application. It is a spreadsheet program which is 

used to save and analyze numerical data. 

यो table जस्तै हो । यसमा ठाडा कोठाहरुिाइ कोिुम र तेसान कोठाहरुिाइ रो भलनन्छ भने सानो कोठािाइ cell भलनन्छ ।  

MS Excel is a spreadsheet program where one can record data in the form of tables. It is easy to 
analyse data in an Excel spreadsheet. The image given below represents how an Excel spreadsheet 
looks like: 

 

Excel मा कपत row र column हुन्िन ्? 

• In a Excel 2010, 2016 and 2019 worksheet, there are 1,048,576 rows and 16,384 columns 
and 17179869184 cells 

Formula bar 

A, B, … कोिुमहरू 

Row number 

column L Row 5  भएकािे यो cell िाइ L5 भलनन्छ 

file:///C:/Users/DELL/AppData/1.%20NASA/2021/NASA%20math%20trial%20data%20Grade%205.xlsx


 

 

 

How to open MS Excel? 

To open MS Excel on your computer, follow the steps given below: 

• Click on Start 

• Then All Programs 

• Next step is to click on MS Office 

• Then finally, choose the MS-Excel option 

Alternatively, you can also click on the Start button and type MS Excel in the search option 
available. 

What is a cell? 

A spreadsheet is in the form of a table comprising rows and columns. The rectangular box at the 
intersection point between rows and columns forms a cell. Given below is an image of a cell: 



 

 

 

What is Cell Address? 

The cell address is the name by which is cell can be addressed. For example, if row 7 is interested 
in column G, then the cell address is G7.  

Features of MS Excel 

Various editing and formatting can be done on an Excel spreadsheet. Discussed below are the 
various features of MS Excel.  

The image below shows the composition of features in MS Excel: 

 

• Home 

o Comprises options like font size, font styles, font colour, background colour, 
alignment, formatting options and styles, insertion and deletion of cells and editing 
options 

o  

• Insert 

o Comprises options like table format and style, inserting images and figures, adding 
graphs, charts and sparklines, header and footer option, equation and symbols 

o  

• Page Layout 

o Themes, orientation and page setup options are available under the page layout 
option 

o  



 

 

• Formulas 

o Since tables with a large amount of data can be created in MS excel, under this 
feature, you can add formulas to your table and get quicker solutions  

o  

• Data 

o Adding external data (from the web), filtering options and data tools are available 
under this category 

o  

• Review 

o Proofreading can be done for an excel sheet (like spell check) in the review category 
and a reader can add comments in this part  

o  

• View 

o Different views in which we want the spreadsheet to be displayed can be edited 
here. Options to zoom in and out and pane arrangement are available under this 
category 

For those willing to learn more about MS Excel, can refer to the video given below and understand 
every small aspect of this program in detail. 

Benefits of Using MS Excel 

• Easy To Store Data 

• Easy To Recover Data 

• Application of Mathematical Formulas 

• More Secure: िासवडन राख्न सपकने  

• Data at One Place:  फरक फरक लसटमा डाटाहरू लमिाएर लशषनक अनुसार राख्न सलकन्छ ।  

• Neater and Clearer Visibility of Information: तथ्याङ्क, graph को रुपमा तथ्याङ्क राख्न सलकन्छ ।  

  



 

 

Excel मा फमुनला पिने तररका 

Excel मा जोडिाइ +, घटाउिाइ -, गुणनिाइ * र भागिाइ / लचह्निे जनाइन्छ । र Excel मा फमुनिा 

िेख्न कुनै एउटा cell मा =  लचह्नबाट सूत्र िेख्न सलकन्छ ।  

जस्तैः 

 

लिचार गनुन पने कुराः = लचह्न पलछ िा कुनै पलन operator (+, -, /) अलघ र पलछ space लदनु हुाँदैन ।  

 

Auto Calculation Facility: Sum, average, minimum or min, Maximum or max, Count 

Excel मा िेज ब्रेक 

 Excel मा पेज ब्रेक आाँफै हुन्छ । तपाइको excel sheet धेरै चालिो िा अग्िो छ भने यसिाइ View menu मा गएर print layout बाट कुन पेज कहााँ 

सम्पम छ भनी हनेन सलकन्छ ।  

File extension of Excel: .xls or .xlsx 

File extension of MS word document: .doc or .docx 

File extension of POwer POint : .ppt or .pptx 

 



 

 

How to insert the graph in Excel? 

Process:  

• Select the number to make chart 

• click on Insert Then select the type of chart.  

कुन अवस्प्थामा कस्प्तो चाटन बनाउन सपकन्ि ? 

- One dimension data : line graph, pie chart, column or bar graph 

- Two or more dimensional data: multiple bar graph, stacked bar 

graph 

- If you have English: 34, 45, 56, 67, 78  kind of data, what type of 

graph do you make? 

o line graph or bar graph or pie chart.  



 

 

  



 

 

 

 

MS Powerpoint 
MS PowerPoint is a program that is included in the Microsoft Office suite. It is used to make 

presentations for personal and professional purposes. 

Question: What is MS PowerPoint? 

Answer: PowerPoint (PPT) is a powerful, easy-to-use presentation graphics software program that 
allows you to create professional-looking electronic slide shows.  

The image given below shows the main page of MS PowerPoint, where a person lands when the 
program is opened on a computer system: 

 

Question: How to open MS PowerPoint on a personal computer? 

Answer: Follow the steps below to open MS PowerPoint on a personal computer: 

1. Click on the start button 
2. Then choose “All Programs” 
3. Next step is to select “MS Office” 
4. Under MS Office, click on the “MS PowerPoint”  

A blank presentation is open on the screen. According to the requirement, a person can modify the 
template for a presentation and start using the program. 

Question: What is a PowerPoint presentation or PPT? 



 

 

Answer: A combination of various slides depicting a graphical and visual interpretation of data, to 
present information in a more creative and interactive manner is called a PowerPoint presentation 
or PPT. 

Question: What is a slide show in a PowerPoint presentation? 

Answer: When all the slides of a PowerPoint presentation are set in series and then presented to a 
group of people, where each slide appears one after the other, is a set pattern, this is known as a 
PowerPoint slide show.  

Question: What all elements can be added to a slide? 

Answer: The following elements can be added to a Powerpoint slide: 

1. Clip Art 
2. Graphs 
3. Tables 
4. Photographs 
5. Charts 
6. Media Clips 
7. Videos 

Features of MS PowerPoint 

There are multiple features that are available in MS PowerPoint which can customise and optimise 
a presentation. The same have been discussed below. 

• Slide Layout 

Multiple options and layouts are available based on which a presentation can be created. This 
option is available under the “Home” section and one can select from the multiple layout options 
provided. 

The image below shows the different slide layout options which are available for use: 

 



 

 

• Insert – Clipart, Video, Audio, etc. 

Under the “Insert” category, multiple options are available where one can choose what feature they 
want to insert in their presentation. This may include images, audio, video, header, footer, symbols, 
shapes, etc.  

The image below shows the features which can be inserted: 

 

• Slide Design 

MS PowerPoint has various themes using which background colour and designs or textures can be 
added to a slide. This makes the presentation more colourful and attracts the attention of the 
people looking at it. 

This feature can be added using the “Design” category mentioned on the homepage of MS 
PowerPoint. Although there are existing design templates available, in case someone wants to add 
some new texture or colour, the option to customise the design is also available. Apart from this, 
slide designs can also be downloaded online. 

Refer to the below for slide design: 

 

• Animations 

During the slide show, the slides appear on the screen one after the other. In case, one wants to add 
some animations to the way in which a slide presents itself, they can refer to the “Animations” 
category.  

The different animation styles available on PowerPoint are: 

 



 

 

Apart from all these options; font size, font style, font colour, word art, date and time, etc. can also 
be added to a PPT.  

Q 1. How many maximum slides can be added to a PowerPoint presentation? 

1. 50 
2. 500 
3. No fixed number 
4. 25 
5. 300 

Answer: (3) No fixed number 

Q 2. Slide Sorter view can be selected under which of the following categories? 

1. Home 
2. File 
3. Edit 
4. View 
5. Review 

Answer: (4) View 

Q 3. The combination of which keyboard keys can be used as a shortcut to add a new slide in MS 
PowerPoint? 

1. ctrl+S 
2. ctrl+L 
3. ctrl+M 
4. ctrl+N 
5. ctrl+P 

Answer: (3) ctrl+M 

Q 4. Header and Footer option is available under which of the following categories? 

1. Insert 
2. Design 
3. Review 
4. View 
5. Home 

Answer: (1) Insert 

Q 5. Which of the following is not included in the “Insert” category in MS PowerPoint? 

1. Shapes 
2. Table 
3. Equation 
4. Animation 
5. Video 



 

 

Answer: (4) Animation 

                                        MS WORD  

1. Which enables us to send the same letter to different persons? 

A. macros  B. template   C. mail merge    D. none 

2. Which key deletes the character to the left of the cursor? 

A. End   B. Backspace    C. Home   D. Delete 

3. Which key deletes the character to the right of the cursor? 

A. End   B. Backspace  C. Home  D. Delete 

4. Which would you choose to save a document with a new name? 

A. Press Ctrl+S     B. Click File, Save    C. Click Tools, Options, Save 

D. Click File, Save As 

5. Which would you choose to move selected text from one place to another? 

A. Move and Paste   B. Copy and Paste     C. Cut and Paste  D. Delete and Paste 

6. How do you magnify your document? 

A. View, Zoom  B. Format, Font  C. Tools, Options  D. Tools, Customize 

7. Which enables you to move directly to specific location in a document? 

A. Subdocuments  B. Bookmarks   C. Cross-references  D. Outlines 

8. What are inserted as cross-reference in Word? 

A. Placeholders  B. Bookmarks   C. Objects  D. Word fields 

9. Which keystroke is used for updating a field? 

A. F6     B. F9      C. F11    D. F12 

10. A master document contains ………, each of which contains a pointer to a file on a 

disk? 

A. Placeholders  B. subdocuments   C. bookmarks   D. references 

 

========================= 

 

 

 

 



 

 

 

 

11. When typing in a word field manually, what must you press to insert the code’s 

braces? 

A. Ctrl + F6      B. Ctrl + F9   C. Alt + F11   D. Shift + F12 

12. A word field may consist of an optional field instruction called a(n) ………….. 

A. subdocument    B. symbol    C. signal   D. switch 

13. Footnotes, endnotes, and indexes are all inserted as …………. 

A. bookmarks   B. cross-references   C. hyperlinks  D. word fields 

14. Before creating a master document, you must switch to..…… 

A. Normal View   B. Outline View   C. Web Layout View  D. Print Layout View 

15. Before moving a subdocument to another location within a master document, you must 

switch to ………….. 

A. Normal View   B. Outline View   C. Web Layout View  D. Print Layout View 

16. Which of the following can be used to navigate documents? 

A. frames  B. hyperlinks    C. web toolbar  D. all of the above 

17. Which of the following can be used to divide a web page into areas? 

A. frames  B. theme  C. table of contents   D. none of the above 

18. By default, Word automatically formats each heading in a table of contents as ……….. 

A. bookmarks   B. cross-references  C. hyperlinks   D. word-fields 

19. The ability to combine name and addresses with a standard document is called ………. 

A. document formatting              B. database management 

C. mail merge                                 D. form letters 

20. Which feature is used for monitoring all document changes? 

A. Edit Document  B. Monitor Change  C. Track Change  D. Track all 

========================= 

 

 

 

 



 

 

 

21. When sharing data in Office, the ……… document is the document in which the data 

was first entered. 

A. source           B. destination             C. original              D. primary 

22. Which command is used to establish a link between a source document and a 

destination document? 

A. Tools, Link, Documents                  B. Tools, Link 

C. Edit, Link                                           D. Edit, Paste Special 

23. Which option enables automatic updates in destination documents? 

A. embedding     B. objects     C. links         D. relationships 

24. Which is an Office feature that makes it easy to edit embedded objects? 

A. pasting       B. visual editing   C. tools, update, links   D. edit, links 

25. Which is true when you insert an excel worksheet into a word document? 

A. word is the destination document   B. excel is the destination document 

C. the worksheet is the destination document 

D. the document is the source document 

26. What would you do when you want to update the data in an embedded worksheet 

range? 

A. double click the worksheet range object 

B. right click worksheet range object & choose format object 

C. edit the data in the destination document 

D. edit the data in the source document. 

27. Which can be used for quick access to commonly used commands and tools? 

A. Status bar  B. Tool bar    C. Menu bar    D. Title bar 

28. With which view can you see how text and graphics will appear on the printed page? 

A. Normal   B. Print Layout   C. Outline   D. Web Layout 

29. Which simplifies the process of formatting text if the same formatting is required in 

more than one location? 

A. Auto Text   B. Format Painter   C. Font dialog box   D. None of the above 

30. Which of the following is best for quick copy operation? 

A. Copy and Paste  B. Windows Clipboard  C. Drag and Drop  D. Auto Text 

31. Which simplifies the process of formatting text if the same formatting is required in 

more than one location? 

A. Auto Text   B. Format Painter C. Font dialog box D. None of the above 



 

 

32. Which of the following is best for quick copy operation? 

A. Copy and Paste  B. Windows Clipboard  C. Drag and Drop  D. Auto Text 

33. Which of the following operations moves text from clipboard? 

A. Copy  B. Paste  C. Drag and Drop  D. Cut 

34. Which of the following provides a list ofx synonyms? 

A. Find command    B. Replace Command   C. Thesaurus   D. Spelling and 

Grammar 

35. Which of the following helps to reduce spelling error in the document? 

A. Auto Format  B. Auto Correct  C. Smart Tags  D. Auto Text 

36. Auto text and Auto correct are ___________ tools. 

A. styling  B. editing    C. designing   D. none of the above 

37. Which of the following enables you to make multiple changes in a document at once? 

A. find command  B. Replace command    C. Drag and Drop       D. copy command 

38. Which of the following commands should you always use before submitting a 

document to others? 

A. find command    B. Replace command     C. Spelling and Grammar     D. Thesaurus 

39. Which of the following enables you to paste data multiple times? 

A. windows clipboard   B. office clipboard  C. both A and B  D. none of the above 

40. Which of the following do you use to change margins? 

A. formatting toolbar   B. page setup dialog box  C. Standard toolbar 

D. paragraph dialog box 

 

 

 

 

41. Which do you press to force a page break? 

A. CTRL+ALT      B. CTRL+ break     C. CTRL+ Enter  D. none of the above 

42. Which do you choose to create footer? 

A. format, header and footer               B. view, footer 

C. insert, header and footer                 D. view, header and footer 



 

 

43. Which do you choose to create header? 

A. format, header and footer             B. view, header 

C. insert, header and footer               D. view, header and footer 

44. Which do you choose to shade words and paragraph? 

A. format, borders and shading             B. insert, borders and shading 

C. view, shading                                       D. none of the above 

45. to view headers and footers, you must switch to 

A. normal view     B. print layout view    . print preview mode  D. both B and C 

46. Which of the following can you change using the page setup dialog box? 

A. margins   B. page orientation   C. vertical alignment   D. all of the above 

47. By default, your document prints with: 

A. 1 inch top and bottom margins             B. a portrait orientation 

C. 1.25 inches left and right margins         D. all of the above 

48. switching between portrait and landscape modes involves the: 

A. header and footer toolbar                   B. print layout view 

C. page setup dialog box                           D. none of the above 

49. What happens when you insert an AutoShape by simply clicking in the document? 

A. it appears near the insertion point            B. it is inserted in its default size 

C. is selected                                                       D. all of the above 

50. What must be used to control the layering of objects? 

A. formatting toolbar          B. picture toolbar 

C. drawing toolbar               D. image toolbar 

 

 

 

 

51 What is the shortcut key to “Center Align” the selected text? 

A. Ctrl + C   B. Ctrl + E       C. Ctrl + F    D. None of above 

52 What is the shortcut key to “Undo” the last action in a document? 

A. Ctrl + X     B. Ctrl + Y     C. Ctrl + Z       D. None of above 

53 What is the shortcut key to “Insert Hyperlink” in a document? 

A. Ctrl + H       B. Ctrl + L     C. Ctrl + K      D. None of above 



 

 

54 What is the shortcut key for “Find and Replace” dialog box? 

A. Ctrl + F     B. Ctrl + R     C. Ctrl + H    D. Ctrl + Shift + F 

55 What is the shortcut key for Spelling Check in document? 

A. F7       B. Shift + F7      C. Ctrl + F7    D. Alt + F7 

56 What is the shortcut key to Update Formula in a table? 

A. F9        B. Alt + F9    C. Ctrl + F9       D. Shift + F9 

57 What is the shortcut key to Close Active Document in Microsoft Word? 

A. Ctrl + F4     B. Shift + F4     C. Ctrl + Shift + F4   D. None of above 

58 What is the shortcut key for “Font” dialog box? 

A. Ctrl + F    B. Ctrl + D      C. Ctrl + G       D. None of the above 

59 What is the shortcut key for “Superscript” the selected text? 

A. Ctrl + =       B. Ctrl + -    C. Ctrl + Shift + =    D. Ctrl + Shift + - 

60 What is the shortcut key for “Subscript” the selected text? 

A. Ctrl + =        B. Ctrl + -        C. Ctrl + Shift + =     D. Ctrl + Shift + - 

 

 

 



 

 

61. Which of the following is not valid version of MS Office? 

  A) Office XP   B) Office Vista   C) Office 2007  D) None of above 

  

62. You cannot close MS Word application by 

  A) Choosing File menu then Exit submenu   B) Press Alt+F4    

 C) Click X button on title bar    D) From File menu choose Close submenu 

  

 63. The key F12 opens a 

  A) Save As dialog box     B) Open dialog box    C) Save dialog box  

 D) Close dialog box 

   

64. What is the short cut key to open the Open dialog box? 

  A) F12      B) Shift F12     C) Alt + F12    D) Ctrl + F12 

  

 65. A feature of MS Word that saves the document automatically after certain interval is available on 

  A) Save tab on Options dialog box    B) Save As dialog box 

 C) Both of above       D) None of above 

   

66. Where can you find the horizontal split bar on MS Word screen? 

  A) On the left of horizontal scroll bar   B) On the right of horizontal scroll bar 

 C) On the top of vertical scroll bar   D) On the bottom of vertical scroll bar 

   

67. Which of the following is not available on the Ruler of MS Word screen? 

  A) Tab stop box      B) Left Indent   C) Right Indent   D) Center Indent 

 E) All of them are available on ruler 

  

 68. What is place to the left of horizontal scroll bar? 

  A) Tab stop buttons  B) View buttons   C) Split buttons  D) Indicators 

 E) None of above 



 

 

  

 69. Which file starts MS Word? 

  A) Winword.exe    B) Word.exe    C) Msword.exe   D) Word2003.exe 

   

70. How many ways you can save a document? 

 A) 3      B) 4             C) 5      D) 6 

  

 71. If you want to keep track of different editions of a document which features will you use? 

  A) Editions          B) Versions     C) Track Change     D) All of above 

   

72. Background color or effects applied on a document is not visible in 

  A) Web layout view     B) Print Layout view    C) Reading View   D) Print Preview 

  

 73. What is a portion of a document in which you set certain page formatting options? 

  A) Page     B) Document      C) Section      D) Page Setup 

  

 74. Borders can be applied to 

  A) Cells      B) Paragraph    C) Text     D) All of above 

  

 75. Which of the following is not a type of page margin? 

  A) Left      B) Right     C) Center      D) Top 

  

  

76. What is the default left margin in Word 2003 document? 

  A) 1"        B) 1.25"     C) 1.5"       D) 2" 

  

 77. What is gutter margin? 

  A) Margin that is added to the left margin when printing 

 B) Margin that is added to right margin when printing 



 

 

 C) Margin that is added to the binding side of page when printing 

 D) Margin that is added to the outside of the page when printing 

  

 78. Portrait and Landscape are 

  A) Page Orientation     B) Paper Size    C) Page Layout     D) All of above 

  

 79. If you need to change the typeface of a document, which menu will you choose? 

  A) Edit        B) View     C) Format     D) Tools 

   

80. Which of the following is not a font style? 

  A) Bold     B) Italics     C) Regular    D) Superscript 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

81. Pressing F8 key for three times selects 

 A) A word   B) A sentence   C) A paragraph   D) Entire document 

  

 82. What happens if you press Ctrl + Shift + F8? 

  A) It activates extended selection   B) It activates the rectangular selection 

 C) It selects the paragraph on which the insertion line is.   D) None of above 

  

 83. How can you disable extended selection mode? 

  A) Press F8 again to disable   B) Press Del to disable   C) Press Esc to disable 

 D) Press Enter to disable 

   

84. What does EXT indicator on status bar of MS Word indicate? 

  A) It indicates whether the external text is pasted on document or not 

 B) It indicates whether extended add-ons are installed on MS Word or not 

 C) It indicates whether Extended Selection mode is turned on or off 

 D) None of above 

  

 85. What is the maximum number of lines you can set for a drop cap? 

  A) 3      B) 10      C) 15           D) 20 

   

86. What is the default number of lines to drop for drop cap? 

 A) 3          B) 10            C) 15      D) 20 

   

87. What is the shortcut key you can press to create a copyright symbol? 

  A) Alt+Ctrl+C         B) Alt + C     C) Ctrl + C       D) Ctrl + Shift + C 



 

 

  

88. How many columns can you insert in a word document in maximum? 

 A) 35        B) 45        C) 55            D) 65 

  

 89. What is the smallest and largest font size available in Font Size tool on formatting toolbar? 

  A) 8 and 72      B) 8 and 64     C) 12 and 72     D) None of above 

   

90. What is the maximum font size you can apply for any character? 

  A) 163        B) 1638          C) 16038             D) None of above 

   

91. Which of the following is graphics solution for Word Processors? 

  A) Clipart            B) WordArt      C) Drop Cap        D) All of above 

  

 

 92. The keystrokes Ctrl + I is used to 

  A) Increase font size           B) Inserts a line break       

  C) Indicate the text should be bold      D) Applies italic format to selected text 

  

 

 93. A character that is raised and smaller above the baseline is known as 

  A) Outlined            B) Raised      C) Superscript    D) Subscript 

  

 94. What is the purpose of inserting header and footer in document? 

  A) To enhance the overall appearance of the document 

 B) To mark the starting and ending of page 

 C) To make large document more readable 

 D) To allow page headers and footers appear on document when printed 

  

 95. Which of the following function key activates the speller? 



 

 

  A) F5            B) F7            C) F9                  D) Shift + F7 

   

96. The minimum number of rows and columns in MS Word document is 

  A) 1 and 1          B) 2 and 1          C) 2 and 2        D) None of above 

  

 97. Thesaurus tool in MS Word is used for 

 A) Spelling suggestions         B) Grammar options       

C) Synonyms and Antonyms words       D) All of above 

  

 98. Why Drop Caps are used in document? 

A) To drop all the capital letters    
B)  B) To automatically begin each paragraph with capital letter 

 C) To begin a paragraph with a large dropped initial capital letter 

 D) None of above 

  

 99. A bookmark is an item or location in document that you identify as a name for future reference. 

Which of the following task is accomplished by using bookmarks? 

A) To add anchors in web page     

B) To mark the ending of a paragraph of document     

C) To quickly jump to specific location in document 

 D) To add hyperlinks in webpage 

 

100. A word processor would most likely be used to do 

 A) Keep an account of money spent     B) Do a computer search in media center 

 C) Maintain an inventory       D) Type a biography 

  

  

  

 

 



 

 

 

 

 

 

 

 

101. What happens when you click on Insert >> Picture >> Clip Art 

  A) It inserts a clipart picture into document 

 B) It lets you choose clipart to insert into document 

 C) It opens Clip Art taskbar 

 D) None of above 

  

 102. Which option is not available in Insert Table Autofit behavior? 

  A) Fixed Column Width     B) AutoFit to Contents    

 C) Autofit to Window      D) Autofit to Column 

  

 103. To autofit the width of column 

A) Double click the right border of column  
B)  B) Double click the left border of column 

 C) Double click the column header 

 D) All of above 

  

 104. From which menu you can insert Header and Footer? 

 A) Insert Menu      B) View Menu   C) Format menu    D) Tools Menu 

  

 105. After typing header text, how can you quickly enter footer text? 

  A) Press PageDown key and type the text for footer 

 B) Click on Switch between Header & Footer then type the text 

 C) Both of above 

 D) None of above 



 

 

  

 106. When inserting Page number in footer it appeared 1 but you wish to show a. How can you do 

that? 

 A) From format menu choose bullets and Numbering and configure necessary setting 

 B) From Insert menu choose Page Number and specify necessary setting 

 C) Click on Page Number Format tool and specify required setting 

 D) All of above 

  

107. Which of the following statement is false? 

  A) You can set different header footer for even and odd pages 

 B) You can set different page number formats for different sections 

 C) You can set different header footer for first page of a section 

 D) You can set different header and footer for last page of a section 

  

 108. Where can you change the vertical alignment? 

 A) Formatting toolbar        B) Paragraph dialog box 

 C) Page Setup dialog box    D) Standard toolbar 

  

109. To get to the ‘Symbol’ dialog box, click on the ______ menu and choose ‘Symbol’. 

 A) Insert               B) Format          C) Tools          D) Table 

   

110. Which of the following symbol sets would be most likely to contain a mathematical symbol such as 

a degree sign, greater than or equal to, or a Greek letter? 

  A) Wingdings      B) Wingdings 3      C) Webdings     D) Symbol 

  

 111. When assigning a shortcut key to a symbol, you should always try to select a key or key 

combination that is: 

 A) unassigned           B) Located on the ten-key pad section of your keyboard. 

 C) Assigned to another task.        D) From the same font family as the symbol. 

  



 

 

112. Suppose you wanted to create an AutoCorrect entry that would type the words ‘We regret to 

inform you that your submission has been declined’ Of the following choices, which would be the best 

name you could assign to this entry? 

 A) Regret               B) Subdual            

 C) We regret to inform you that your submission has been declined  D) 11 

  

 113. If you want to convert a symbol or several lines of text into an AutoCorrect entry, you should: 

  A) Insert the symbol or type the text in a Word document first. Then, select the text or symbol and 

go to the AutoCorrect dialog box. 

 B) Click the Tools menu and choose AutoCorrect Options. Then, click the Insert menu and choose 

Symbol (or click the Format menu and choose Paragraph) to add the symbol or paragraph to 

AutoCorrect. 

 C) AutoCorrect can only accommodate one line of text. It is not possible to convert a symbol or 

multiple lines of text into an AutoCorrect entry. 

 D) Insert the symbol or type the text in a Word document first. Then, select the text or symbol and 

click the Edit menu followed by Paste Special. Select New AutoCorrect Entry and then click OK. 

 

114. AutoCorrect was originally designed to replace _________ words as you type. 

 A) Short, repetitive        B) Grammatically incorrect 

 C) Misspelled          D) None of the above 

  

 115. Which of the following is the second step in creating a macro? 

  A) Start recording 

 B) Using your mouse or keyboard, perform the task you want to automate 

 C) Assign a keyboard shortcut to the macro 

 D) Give the macro a name 

  

  

116. If you will be displaying or printing your document on another computer, you’ll want to make sure 

and select the _____________ option under the ‘Save’ tab. 

  A) Embed Fonts    B) Embed True Type Fonts 

 C) Save True Type Fonts   D) Save Fonts 



 

 

  

 

 

 117. In Word, the mailing list is known as the ____________. 

  A) Data sheet                                          B) Source 

 C) Data source     D) Sheet 

  

 118. Which of the following is not one of the three ‘Mail Merge Helper’ steps? 

  A) Merge the two files    B) Create the main document 

 C) Set the mailing list parameters   D) Create the data source 

  

119. Which of the following button will allow you to add, delete, or change records in your Data 

Source? 

  A) ‘Data Source’ button    B) ‘Edit’ button 

 C) ‘Edit Data Source’ button   D) ‘Data editing’ button 

  

 120. It is possible to _______ a data source before performing a merge. 

  A) Create     B) Modify 

 C) Sort     D) all of the above 

  

  

  

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

121. What is the default font size of a new Word document based on Normal template? 

  A) 10 pt                    B) 12 pt                 C) 14 pt                 D) None of above 

  

122. What is the default font used in MS Word document? 

 A) Times New Roman            B) Arial     C) Algerian     D) Preeti 

  

123. Which tab in Font dialog box contains options to apply font effects? 

  A) Font tab     B) Character Spacing    C) Text Effects   D) Standard Toolbar 

   



 

 

124. If you need to double underline a word, how will you do that? 

 

  A) Go to Format menu and then Font option. Open Underline Style and choose Double Underline 

 B) From Format menu choose Font option and then from Font tab open Underline Style and select 

Double Underline 

 C) Select the text then choose Format >> Font and on Font tab open Underline Style and choose 

Double Underline 

 D) Click double underline tool on formatting toolbar 

  

 125. DropCap means 

  A) All Caps            B) Small Caps           C) Title case             D) None of above 

   

126. What is the short cut key to open Font dialog box? 

 A) Ctrl + F          B) Alt + Ctrl + F     C) Ctrl + D           D) Ctrl + Shift + D 

  

 127. How can you access the font size tool on formatting toolbar? 

 A) Ctrl + S     B) Ctrl + Shift + S      C) Ctrl + P    D) Ctrl + Shift + P 

  

 128. How can you make the selected character superscripted? 

 A) Ctrl + =  B) Ctrl + Shift + =  C) Alt + Ctrl + Shift + =  D) None of above 

   

129. What does Ctrl + = key effect? 

  A) Superscript    B) Subscript         C) All Caps    D) Shadow 

 

 130. What happens if you mark on Hidden check box of Font dialog box after you select some text? 

  A) The text is deleted from document and you need to bring from Recycle Bin if required again. 

 B) The text is hidden and you need to bring it by removing the check box if needed again 

 C) The text is deleted and cannot be returned back 

 D) The text is hidden and cannot be returned back 



 

 

  

 

 

 

 131. How can you increase the font size of selected text by one point every time? 

  A) By pressing Ctrl + ] 

 B) By pressing Ctrl + [ 

 C) By pressing Ctrl + } 

 D) By pressing Ctrl + { 

  

 132. Which of the following line spacing is invalid? 

  A) Single  B) Double   C) Triple       D) Multiple 

   

133. How can you apply exactly the same formatting you did to another text? 

  A) Copy the text and paste in new location. Then type the new text again. 

 B) Copy the text and click on Paste Special tool on new place 

 C) Select the text then click on Format Painter and select the new text 

 D) All of above 

  

 134. What should you do if you require pasting the same format in many places? 

 A) Click the Format painter and go on pasting in many places holding Alt Key 

 B) Double click the format painter then go on pasting in many places 

 C) Click the format painter then go on pasting to many places holding Ctrl Key 

 D) All of above 

  

 135. On which toolbar can you find Format Painter tool? 

 A) Standard toolbar   B) Formatting toolbar  

C) Drawing Toolbar     D) Picture Toolbar 

  



 

 

 136. Which indent marker controls all the lines except first line? 

  A) First Line Indent Marker   B) Left Indent Marker 

 C) Hanging Indent Marker      D) Right Indent Marker 

  

 137. How can you remove tab stop markers from ruler? 

  A) Double click the tab marker and choose Clear All 

 B) Drag the tab stop marker out of the ruler 

 C) Right click the tab stop marker and choose remove 

 D) All of above 

  

 138. Which operation you will perform if you need to move a block of text? 

  A) Copy and Paste  B) Cut and Paste   C) Paste and Delete  D) Paste and Cut 

  

139. What is the extension of Word files? 

 A) FIL         B) DOT          C) DOC            D) TXT 

   

140. Which of the following option is not available in Insert >> Picture? 

  A) Chart         B) Word Art     C) Clip Art          D) Graph 

 

 

 

  

141. To insert a drop cap in one of the paragraph you should access 

  A) Insert Menu B) Format  C) Tools  D) None of above 

   

142. How many different positions can you set for drop cap? 

  A) 1   B) 2   C) 4   D) 6 

  

 143. What is the maximum number of lines you can set for lines to drop box? 



 

 

 A) 3   B) 5  C) 10   D) 15 

   

144. Which of the following can NOT be used to create parallel style column? 

 A) Format Tabs    B) Table Insert Table   

C) Insert Textbox    D) Format Columns 

  

 145. Which of the following is used to create newspaper style columns? 

  A) Format Tabs    B) Table Insert Table 

 C) Insert Textbox    D) Format Columns 

  

 146. Columns dialog box can be opened from 

  A) Format menu Columns submenu  B) Double click on column space in ruler 

 C) Press Alt + O + C    D) All of above 

   

147. You can jump to the next column by 

  A) Clicking with your mouse on the next column  B) Press Alt + Down-arrow 

 C) Both of above       D) None of Above 

   

148. How can you break the current column and start a new column immediately? 

  A) Press Ctrl + Shift + Enter    B) Press Alt + Enter 

 C) Press Ctrl + Enter     D) Press Alt + Shift + Enter 

  

 149. What is the smallest width of a column? 

  A) 0"   B) 0.5"   C) 1"   D) 1.5" 

  

 150. If the number of columns is selected 1 and the line between check box is marked, where is the 

line drawn? 

  A) in the left margin    B) in the right margin 

 C) both in left and right margin   D) None of Above 



 

 

  

  

151. The other Col# are inactive when you’ve select 3 columns. How will you activate those boxes? 

A) double click on spacing box    

B) double click on inactive Col# 

C) Remove mark from Line between checkbox 

D) Remove mark from Equal Column Width check box 

  

152. How much space in minimum must be provided between columns? 

 A) 0"   B) 0.5"   C) 1"   D) 1.5" 

  

 153. To open Columns dialog box quickly 

A) double click on the left margin area of ruler   
B) double click the space between area on ruler 

 C) double click the right margin in ruler 

 D) All of above 

  

 154. Which of the following command is not available in Tools menu? 

  A) Auto text  B) Autocorrect  C) Auto summarize   D) Macro 

   

155. To move the cursor page to page of document 

  A) Ctrl+PgDn  B) Ctrl+PgUp     C) Both of above   D) None of above 

  

 156. Text boundary can be displayed or hidden from 

  A) Auto text option from Insert menu   B) Options from Tools menu 

 C) Customize from Tools menu    D) All of above 

  

 157. Which of the following are word processing software? 

  A) WordPerfect  B) Easy Word  C) MS Word   D) All of above 

  



 

 

 158. MS Office provides help in many ways, which of these is one of them? 

  A) What is this?  B) Office Assistant  C) Help menu  D) All of the above 

  

 159. You wished to justify text over the height of paper, which option will you choose 

  A) Page Setup from File menu   B) Paragraph from Format menu 

 C) From formatting toolbar   D) Font from Format menu 

  

 160. Which of the following is not of the merge process? 

 A) Sort the data source records   B) Format a main document 

 C) Edit a data source    D) Merge the two files to print or create a new document 

  

 

 

 

 

  

 

 

 

 

 

 

 

161. There can be many ways to insert page number in a document. Which of the following lets you 

insert page number 

  A) Page number from Insert menu  B) Page Setup from file menu 

 C) Footnote from Insert menu     D) Both a & c 

  

 162. Which is not a data source component? 



 

 

 A) mail merge toolbar      B) header row     C) data fields       D) data records 

  

 163. Which of the following is not the part of standard office suite? 

  A) Word Processor     B) Database   C) Image Editor   D) File manager 

  

 164. Where can you find the Draw Table tool button? 

  A) Standard toolbar     B) Formatting toolbar 

 C) Drawing toolbar     D) Tables and Formatting toolbar 

  

 165. Which of the following option in File pull down menu is used to close a MS Word document? 

  A) Quit   B) Close   C) Exit   D) New 

  

166. You need to jump to the next column breaking current column right at the cursor position. How 

can you break column? 

 A) Pressing Ctrl+Enter     B) Pressing Alt+Shift+Enter 

 C) Break command from Insert menu   D) Both b and c 

  

 167. Superscript, subscript, outline, emboss, engrave are known as 

  A) font styles  B) font effects  C) word art   D) text effects 

  

 168. Shimmer, Sparkle text, Blinking Background etc. are known as 

  A) font styles  B) font effects  C) word art   D) text effects 

  

 169. The feature of Word that automatically adjusts the amount of space between certain combination 

of characters so that an entire word looks more evenly spaced. What is that feature called? 

  A) Spacing   B) Scaling   C) Kerning   D) Positioning 

   

170. Which of the following is not available in Font Spacing? 

  A) Normal   B) Loosely  C) Condensed  D) Expanded 



 

 

  

 171. Which of the following position is not available for fonts on MS Word? 

  A) Normal   B) Raised  C) Lowered   D) Centered 

  

 172. What is the maximum scale percentage available in Scale drop down box? 

  A) 500   B) 200  C) 100   D) 90 

  

 173. Bold, Italic, Regular are known as 

  A) font styles  B) font effects  C) word art   D) text effects 

  

 174. Uppercase on Change Case dialog box and All Caps on Fonts dialog box both converts selected 

text into Capital Letters. What’s the difference between the two? 

  A) Both are same. They are only two different ways of capitalize text. 

 B) It is faster to convert from Change Case than from Font dialog box 

 C) Change Case makes conversion permanent but All Caps on Font can always be reverted 

 D) All Caps on Font dialog box makes the change permanent where Change Case can be always 

reverted 

  175. If you need to hide some paragraphs, how can you do it? 

  A) From Paragraph dialog box 

 B) From Font dialog box 

 C) From Options Dialog box 

 D) None of above 

  

 176. Which of the following is the latest version of MS Word? 

  A) Word 2000  B) Word 2007  C) Word 2010  D) Word 2011 

  

 177. Changing the appearance of a document is called 

 A) Proofing   B) Editing  C) Formatting  D) All of above 

  



 

 

 178. In a document what is the maximum number of columns that can be inserted in MS Word Table? 

  A) 35    B) 15   C) 63           D) 65 

  

 179. You can detect spelling and grammar errors by 

  A) Press Shift + F7    B) Press Ctrl + F7 

 C) Press Alt+ F7    D) Press F7 

   

180. A screen element of MS Word that is usually located below the title bar that provides categorized 

options is 

  A) Menu Bar  B) Tool Bar   C) Status Bar   D) All of the above 

  

   

 

 

 


